SiGNAL

— WIRELESS TELEMETRY —

Users Guide

Remote Sensor Configuration

The SignalFire Remote Sensor Configuration allows the configuration of HART devices using the SignalFire
ToolKit wirelessly through a SignalFire Ethernet Gateway or from the Gateway RS232 debug port. The ToolKit
has built in quick configuration for common parameters for the Vega Flex81 series guided wave radars,
Magenetrol 706 series GWS, Rosemount 5300 series GWR and the Yokogowa EJA series pressure transmitters.
When using one of these devices many common settings can be changed quickly from within the SignalFire
ToolKit software.

Additionally, either PACTware, RadarMaster, DeviceCare, and FieldCare can be operated though this wireless
interface for advanced configuration or configuration of other sensor types.

Quick Configuration
After a remote node has been brought into a remote configuration session (see the Gateway manual for

details), select the '"HART Sensor Advanced Configuration’ menu item. This will open the quick configuration
for the detected remote device.

For each supported HART device, the identification information and current HART variables will be displayed.

The quick settings that are available for the detected device are also displayed. To change any settings, make
the desired changes and click on the corresponding set button.
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i HART Senscr Advanced Configuration

|VEGAFLEX 81 |

| Refresh All Values |

Device |dentifier & Status

Mfg. ID Code |62

Mfq. Dev. Type Code | (kD5

| Be737DC6
| B0

Device |0 Mumber

Field Device Status

Probe
Probe Length |4.000
Set Probe Length

Application
Type of medium | Liquids
Application | Interface in the vessel

Supermposed gas layer present | Yes

Dielectric constant of upper medium

Set Application Parameters

False Signal Suppression

Sounded distance from the sealing suface to
the medium 0.00 ft

Execute

Success

- | X

Change Address
Polling Address |1 i Address |1 >
Timeout (sec) . 7 Set Address
Device VYariables
Loop Current (mA) 40 |
Primary Variable (PV) ~ |56.348 % |
Secondary Variable (SV) (70.502 % |
Tettiary Variable (TV) ~ [1.622 #t |
Quatemary Variable (QV) (69.096 °F |
HART Values
First HART value (PV) Percentage, intefface e
Second HART wvalue (5V) | Lin. percent, level e

Third HART wvalue (TV) | Distance to level
Fourth HART value (3V) | Blectronics temperature

Set HART Values

Level Adjustment

Max. adjustmertin % | 100.00 %
Distance A |0.000 |t
Min. adjustmentin % |0.00 %
Distance B |5.500 |t

Set Level Adjustment

Inteface Adjustment

Max. adjustmertin % |100.00 T
Distance C |0.000 |t
Min. adjustmentin % |0.00 %
Distance D |5.000 |t

Set Inteface Adjustment

Example VEGA Flex 81 configuration screen
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i HART Sensor Advanced Configuration

| Magnetral Eclipse 706

| Refresh All Values

Device |dentifier & Status

Mfg. ID Code |56 |
Mfg. Dev. Type Code | OxED |
Device ID Number  |OxDDBEF4 |
Field Device Status | 0x48 |
Identity

Product Mame |Edipse Model 706 |
5/N FF—FF—FF-FF—FF—FF—FF—FF—FF—FF—FF|
HW Version 3 |
FW Version |Verx1. 1A |
Long Tag |Mag?ﬂlﬁ |

Set Long Tag

Basic Configuration
Measurement Type | Imterface and Level
Level Units cm w
[] 705 Adaptor
Probe Model T Coax Std ~
Probe Mount NPT ~
Probe Length em
Level Offset cm
Diglectric Range Below 1.7 W
Upper Dielectric

Set Bagic Configuration

Success

s

- O
Change Address
Polling Address | 1 w Address |1 y
Timeout (sec) . Set Address
Device Varables
Loop Current {mA) 4.0 |
Primary Variable (PV) (1.9 em |
Secondary Variable (SV) |68.5 cm |
Tettiary Variable (TV) ~ |70.4 cm |
|

Quatemary Variable (QV) [20.9 C

HART Values

First HART wvalue (PV) Interface Thickness
Second HART value (5V) | Inteface Level
Third HART value (TV) | Level

Fourth HART value (QY) | Temperature

Set HART Values

Advanced Configuration
Sensitivity 1
Level Trim 43 cm

Level Threshold Value |20

Set Advanced Configuration

Example Magnetrol 706 configuration screen
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i HART Sensor Advanced Configuration — O et
Change Address

|Hnsernuurrt Guided Wave Radar | Polling Address | 1 A Address [ i
[ Refresh All Values | Timeout sec) |5 - ot A
ress
Device |dentifier & Status Device Variables
Mfg. ID Code |26 | Loop Current (mA) 20 |
Vig. Dev. Type Code 05T | Primary Variable (PV) NaN |
e |{b: | Secondary Varable (5V) |NaN in/min |
e |{b:DE | Tertiary Variable (TV) |NaN in/min |
HART Variables Quatemary Variable (QV) [NaN mV |
Output Source (PV) | Volume ~ Probe
Output Source (SV) | Level Rate ¥ Probe Type | Flexible Single PTFE v
=2in i | Probe Length [20.000 |t
Set HART Variables Hold Off Distance/UNZ |0.000 |ft
Tank Geometry Set Probe Parameters
Tank Height (R) f Environment
Mounting Type | Unknown > Upper Product Dielectric Constant Set
Inner Diameter, Pipe/Chamber/MNozzle
Advanced
Unknown

[] Use Atomatic Suface Threshald
Mozzle Height 1.110 ft

Surface Threshold  |413 mY
Calibration Distance ﬁ _ Cet

[] Use Atomatic Interface Threshold

| Show level bel beendas 0
ow level below probe end as ntefface Threshold mv
Set Tank Geometry

Success

Example Rosemount 5300 configuration screen
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i HART Sensor Advanced Configuration — O >

. Change Address
|‘1‘nkngawa EJA Pressure Sensor | Foling Address |1 "1 Address 1 v
| Refresh All Values | Timeout sec) |5 et Address
Device ldentifier & Status Device Vargbles
Mfg. ID Code |0x37 | Loop Curent {mA) |40 |
Mfg. Dev. Type Code |{!:5C | Primary Variable (PV) |.ﬂ_25;ﬁ pai |
Device ID Number  [0x31EBSE | Secondary Variable (SV) [0.0 psi |
Field Device Status |{b:43 | Tertiary Variable (TV) |2ﬂ.1]33 T |
Device Vanable Information Quatemary Varable (QV) |{nnne} |
Linit pi ™ Display Select
Lower Sensor Limit |-14.5 psi | Display Output 1 | PRES % e

Upper Sensor Limit |T-"251 S psi | Set Display Output

Min. Span |_.-"25.2 psi |
Lower Range Value psi
Upper Range Value 72000 psi

Set Unit and Range Values

Success

Example Yokogawa EJA configuration screen
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Remote PACTware and Radar Master

Installation

Install the SignalFire Virtual Serial Port driver (Required for both PACTware and Radar Master)

From the main ToolKit window go to the Help menu, select Drivers, and select Install SignalFire Virtual Serial
Port. Follow the installation prompts

Install the HART Communication DTM Driver for PACTware

From the main ToolKit window go to the Help menu, select Installer Downloads, and select Download
CodeWrights HART CommDTM Installer.

e Unzip and run setup.exe from the downloaded .zip file

e Open PACTware and go to the “view” menu and select “device catalog”

e C(lick on the ‘Update device catalog” button to install the driver.

e Confirm that the CodeWrights GmbH driver appears under the devices menu.

File  Edit View Project Device Extras Window

DSE4E @ [BE) =290 9 8 =

B
| All Devices All Devices
Device | Protocol |Vendur
HART 1CS GmbH

“:,',‘ HART Communication HART CodeWrights GmbH

Bojejes aneag) E

Vendor l Group | Type | Protocol J

Show unselected devices too M

<Lm Update device catalog

s
<> |_||_| <NONAME> Administrator
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Wireless PACTware Mode

The following steps are necessary to complete a PACTware session.

1. Place the SignalFire Node into Remote Configuration Mode
Click the “Start PACTware 4.1" button. Note the virtual COM port listed in the pop-up window.

PACTware will automatically open.

2. Connect to HART sensor
Once PACTware opens, connecting to the HART sensor is slightly different than you may be used to.

Double click on the COM port to open the COM configuration. Select the SignalFire Virtual Serial Port. Click
“Apply and “OK". Then right click on the COM port in the Project tab and click “Connect”

PACTware == ]
File Edit View Project Device Extras Window Help
DS HS B D200 %83 E
Pre %5 VEGA project assistant | S/ COM51 Parameter 4 b x| 3
Device tag Address [] %ﬁ g'?
HOSTPC =)
H Ccom51 -N@ Communication interfface [HART — ,] :-—_r
=
Serial Interface | COMS! (SignalFire Vitual Serial Port) -
HART protocol Master [F‘rimar:.r Master v]
Mumber of communication 3 -
Numb 3. -
Address scan Start address
End address
Communication timeout seconds
[] Multimaster and Burst mode support
QK ] [ Cancel Apphy
1 | 1 3
A= | <MNOMNAME= Adrinistrator
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3. For Vega devices simply click on the “Start” button in the VEGA project assistant to connect to

the device.

PACTware
File  Edit

View Project Device

(= o =5

Extras  Window  Help

DEEAE @ D220 9858

Project o x
Device tag |A4:I4:Iress | 0 |%§
HOSTPC

< COM51 7 A=

e r

%5 VEGA project assistant 4
[ l

[ 4

[l Connect devices (Cnling)

bojeiea aama @

] Load device data automatically

| O Close window autematically

Cancel

I
[+]x]0]

<NONAME> ||

Administrator

4. For other HART devices use the PACTware Topology scan to detect the attached device

B pology Scan
Scan Path
Issue:SelectaDTM
Scan Tree Device Tvpe |Matching o vl Suppork level | ~
- - YEGA Placehalder DTM HART 93 Ident
Device kag | |nddress |De\-'|ce type (DTM|I VEGARLLS 61 HART a3 Speci n
- pecific
E15) cov d FART Comirical (e Specific
_ Unknown D@ [ 1] VEGAPULS &3 HART o3 Specific
YEGAPLLS 65 HART 93 Specific
YEGARLLS 65 HART 93 Specific
YEGAPLLS 67 HART a3 Specific
YEGAPLULS 65 HART 23 Specific
WEGAPULS WL 61 HART 25 Specific b
[[] 5ave assignment far &l devices af same type
Semantic ID Scan infa Device Type infa ~
[E] HART Revision 5 *
E] Manufacturer Identification « 98 e
[E] Device Type Code 232 ~OF2E307|~0*232]~0*219
E] Software Revision 1 *
[l Hardware Revision 1.0 A -
Bl DeviceCommandRevisionLey 1 A
[E] DeviceFlag ] o
4 ManufacturerspecificExkensi 11062 11162
< | * | @ protacal HART HART v

() (0] [ gose ]

[ Settings ]

Apply
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The attached HART sensor will be detected. Select the correct device DTM for the sensor and click
Apply.

e Close the topology scan window
e Double click on the Sensor to open the device DTM
e Right click on the Sensor and select connect

The PACTware session is now fully active and the sensor may be configured as normal using the device DTM.

When finished, close PACTware and return to the Remote Configuration window. Close this window and then
click on “End Session” in the gateway window to put the node back into normal operation (this will also happen
automatically after a 10 minute inactivity timeout).

Wireless Rosemount Radar Master Mode

Starting a remote Radar Master Session
The following steps are necessary to complete a Remote Radar Master session.

1. After the node has been placed into Radar Master mode, click on “Start Rosemount Radar Master”. This will
automatically open the Radar Master application. A pop-up window will indicate the Virtual COM port
number to use within the RadarMaster application

2. Connect to HART sensor using Radar Master

Select the Virtual Serial Port, additionally the following setting must be changed. See below:

e Handshake = Node

e Response Timeout = 2000

e Retries = 10

e Max HART Query Length = 55
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% Communication Preferences \EI
Modbus T HART T Foundation Fieldbus
Default
v Enable HART Communication
<¢ Basic
Port Settings
Port
|COM4 [Vittual Serial Port 7 (Elima Softwa v |
tModem
|Rs-232 |
Advanced
Baudrate Hahdshake
1200 | |Haone |
Stop Bitz Responze Timeout
1 =l |2000 s
Farity Retries
|0dd | 10
Freamhbles taster Mode
|5 |Secondary j
Max HART Query Length [bytez)
R obust High Speed
L P99
35 195
& Hozt system dependency! See online help for more information,
0k ‘ Cancel Apply Help

Now simply start a Radar Master using the selected COM port and configure the sensor as would normally be
done using a HART modem cable.

When finished, close Radar Master and return to the Remote Configuration window. Close this window and
click on "End Session” to put the Sentinel node back into normal operation (this will also happen automatically
after a 10 minute inactivity timeout).

Wireless DeviceCare/FieldCare Mode

Starting a remote DeviceCare/FieldCare Session
The following steps are necessary to complete a DeviceCare/FieldCare session.

1. After the node has been placed into Remote Configuration Mode, click on “Create Virtual COM Port". A
pop-up window will indicate the Virtual COM port number to use within the DeviceCare/FieldCare
application. This COM port number will be selected in step 7.
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Virtual COM Port >

The HART frame application must be configured to connect to
COM12,

Recommended HART modem parameters:

- Serial interface: COM12

- Modem: R5232

- Response Timeouwt: 2000 ms
- Retries: 10

2. Open the Enress+Hauser DeviceCare or FieldCare application.

3. Select ‘Assistant Connection to device step-by-step’

DeviceCare SFE100

Endress +Hauser (2]

l=]2]_]i2]<

Connection:

Automatic Establish connection to Assistant Connection to device

device automatically step-by-step

11:20 AM
5/13/2019
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4. Select 'HART Connect to HART devices point-to-point or via multidrop’

DeviceCare SFE100

E o

Protocol:

PIRJOIFI I
008

HART Connect to HART devices PROFIBUS Connect to PROFIBUS

point-to-point or via multidrop. DP or PROFIBUS PA devices.

Endress+Hauser (1]

FOUNDATION

FOUNDATION Fieldbus Cornectts  Modbus Connect to Modbus E+Hlnterfaces Connect to devices

devices over serial 1 using CDI, ISS, IPC or PCP.

11:19 AM
5/13/2019

5. Select Interface: 'FXA195’

DeviceCare SFE100

Interface:

FXA195 MACTek Viator USB

-

Microlink HART

]3]l 3]~

Endress+Hauser LZ1]

Protocol Interface Configuration
HART

MACTek Viator Bluetooth Vector InfoTech HART the H@rt Bluepack VEGACONNECT 4

11:22 AM
5/13/2019
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6. Select ‘Advanced’

DeviceCare SFE100

Protocol
HART
Found devices USB port: .

Configuration
HART Communication

Endress+Hauser (3]

| Ix

Samnnge  Susdis 0 st 0

>

11:23 AM

. 5/13/2019

7. Select the appropriate HART modem settings.
- Serial Interface: COMx (SignalFire Virtual Serial Port)
- Number of communication retries: 10
- Start address: 1
- End address: 1

Click ‘Apply’ and ‘OK’
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14

DeviceCare SFE100 Endress+Hauser (2]

Protocol Interface Configuration
FXA195 HART Communication

Communication interface: ‘ HART modem - |

Seral Inteface | COM12 (SignalFire Virtual Senal Port) |

HART protocal Master Secondary Master
Preamble 5 v

Number of communication [ 1g =
retries

Address scan Start address

End address

] Mutimaster and Burst mode support

11:28 AM
5/13/2019
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8. Click the right arrow in the lower right corner to scan for HART devices.

DeviceCare SFE100 Endress+Hauser (2]

Protocol Interface Configuration
HART FXA195 HART Communication
S

The DTM COM1 [HART Communication] has no GUI opened.

Scans the next le

11:31 AM

. -m 5/13/2019

DeviceCare SFE100 Endress+Hauser {Z1]

H S = _ ! E

Connection to device not established...

Problem Remedy

e Connection in progress » please wait

« DTWis offine » please switch DTM Online

« No connection to device or communication adapter » theckwiring and power supply

» check settings of Communication DTM
» check device address

« Communication driver natinstalled » check USB driver installation

& [Check Connested Device Type I

11:42 AM
O -m 5/13/2019
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DeviceCare SFE100 Endress+Hauser (1]

H e - _ ! E

Language  Mode selection

Device Typs:  Cerabar §/ PMx 7x / V02.Ty.zz SOFTWARE VERSION:  02.10.54 MEASURED VALUE: 1 inH20
(’ DEVICE DESIGN.:  PMCT1-ABD1PGAFB2A Tag: CERABARS  OUTPUT CURRENT: 4,000 mA EI’
status signal [ OK MEASURING MODE: ~ Pressure STATUS LOCKING:  Unlocked Endress+Hauser
& MEASURING MODE
& QUICK SETUP
& OPERATING MENU
¥ OK
< >
2 Online 44| ¥F 4 5 Ty Instrument health status
27 |RED- [Comested

11:43 AM

O 5/13/2019
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Technical Support and Contact Information

SignalFire Telemetry

140 Locke Dr, Suite B
Marlborough, MA 01752
(978) 212-2868
support@signal-fire.com

Revision History

Revision Date Changes/Updates

1.0 Initial release

1.1 9/4/15 Added information on quick configuration, updated design

1.2 8/4/21 Added information on DeviceCare/FieldCare

13 11/30/21 Updated screen shots, added detail on Magnetrol 706 quick settings
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